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Course Overview

1. Android environment setup

2. Create New Project




System Requirements

e Hardware
e Windows 7,8,10 (32- or 64-bit)
e Mac OS X 10.5.8 or later (x86 only)
e Limnux (Ubuntu, Lucid Lynx)
e Java Platform, SE
e JDK 6 or7

e Java 8 features are not supported
e JRE alone 1s not sufficient

e Install Java SE first.
e Set environment variable JAVA  HOME




I-Android Environment Setup

Setup Java Development Kit (JDK)
Set Your JAVA  HOME
Install Android Studio
Check for Update
Install System Images and Tools in SDK Manager
Create Android Virtual Device
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1-Setup JDK

1. check i1f you have the Java Developer Kit (JDK) version 6.0 or greater
already 1nstalled

2. If'you do not have Java installed, or 1f your version 1s below 6.0, install the
Java JDK




2-Set Your JAVA HOME

Right click on the Computer- Properties
Advanced System Settings
In the Advanced tab-Click Environment Variables

Create System Variable by Click New Button

Set:
1. Variable Name: JAVA HOME
2. Varnable Value: C:\Program Files\Java\jre7;

6. Click Button OK-OK-OK
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Practice

J ) N R R
ny System Properties [ < | Environment Variables “
Open | Computer Name [ Hardware ‘ Advanced l System Protection | Remote ‘
User variables for USER
Manage You must be logged on as an Administrator to make most of these changes.
Ped Variable Value
Pin to Start emance TEMP %USERPROFILE %\AppDataLocal {Tem
Visual effects, processor scheduling, memory usage, and virtual memory d P
: T™MP %USERPROFILE % \AppData\Local\Temp
Map network drive...
Disconnect network drive...
User Profiles = I l Edit I l Delete
) o ew... e 3
Create shortcut Desktop settings related to your signin
Delete System variables
Variable Value 2
Rename Startup and Recovery
77\ System startup, system failure, and debugging information NUMBER_OF P... 2 )
Propertie( 1 ) 0s Windows _NT
\""/ Path C:\Program Files (x86)\Intel\TXE Compo...
PATHEXT .COM; .EXE; .BAT;.CMD;.VBS;.VBE;.J5;.... V¥

1% @y {E% | Edt. || Deete |

1T 1™ ), Control Panel

ok || cancel |

Control Panel Home

Variable name: JAVA_HOME

® Device Manager

¥ Remote setti i ' '
® Remote settings Variable value: :\Program Files\ava\jre7;

@ System protection

f@' Advanced system se@ (@ OK




3- Install Android Studio

1. Download: http://developer.android.com/sdk/installing/ studio.html

2. Open the downloaded file, and follow the Android Studio Setup Wizard
to complete the installation.



http://developer.android.com/sdk/installing/studio.html

4- Check for Update

1. Open Android Studio.

2. click “Check for updates now” on the green pop-up alerting you of new
updates or navigate to it from the Help menu-Check for update.

3. After updates are mstalled and then restart Android Studio.




Practice

File Edit View Navigate Code Analyze Refactor Build Run Tools VCS Window

BHO #2 | XM QAR (& D4 [wappr] D> ¥k @ ¢ L ind Action... Ctrl+Shift+A

* MyApplication . appl:} s src:} ° main © java © com g example::.‘-‘ - myapplica ¢ Help Topics

&7 Project v} (I - A s

I L2 MyApplication (0 Ucers temp AndroicSiud
i External Libraries

[E MainActivityjava * \— Tip of the Day

package com.example.myapplication.

Productivity Guide

Submit Feedback
Configure Debug Log Settings

Himport ...

Show Log in Explorer

public class MainActivity extends

Online Documentation

f0werride . What's New in Android Studio
protected void onCreate (Bundle

super.onCreate (savedInstan Default Keymap Reference
setContentView(R.layout.ac JetBrains TV

} —_—
Check for Update...
===
@Override About
public boolean conCreateCpticnsMenu(Menu menu) {
/ Inflate the menu; this adds items to the action bar if it 1is present.

getMenuInflater().inflate(R.menu.main, menu);
return true;
}

@Override
public boolean cnOptionsItemSelected(Menultem item) {
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5- Install System Images and Tools in SDK

Manager

1. Launch Android Studio

2. You should see a “Welcome to Android Studio” window. Select Configure — SDK
Manager.

3.  From the SDK manager, you will see a lot of different packages that you can install.
SELECT ONLY THE BOXES SHOWN BELOW

4. Accept the license for each set of packages in order to complete the mstall. You may

need to install each set of packages separately, as they fall under separate licenses.
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Pract

ice

-

= Android Studio =

Py
l@l Welcome to Android Studio

Recent Projects <« Configure

SDK Manager
,& Settings
I.’;\" Plugins
E{Q Import Settings
E}a, Export Settings

No Project Open Yet

VCS Window Help

7

Android SDK

SDK Path: C:\Program Files (x86)\Android\android-studio\sdk

Packages
' Name APl Rev. Status
4[] Tools|
[ ]# Android SDK Tools 23.0.2 ¥ Installed
Drf Android SDK Platform-tools 20 & Installed
[ ]+ Android SDK Build-tools 20 @ Installed
[ |# Android SDK Build-tools 191 & Installed
4 [ |E Android L (API 20, L preview)
|| ' SDK Platform Android L Preview 20 2 @Installed
Dﬁl Intel x86 Atom System Image 20 1 ®Installed
4 [|cz Android 4.4.2 (AP 19)
[ |'# SDK Platform 19 3 @Installed
|| Intel x86 Atom System Image 19 2 @ Installed
[ |i& Google APIs (x86 System Image) 19 6 @ Installed
4[]0 Extras
3 Android Support Repository 6 @ Installed
D 3 Android Support Library 20 & Installed

Tasks & Contexts )-E @ @\E_I/'ﬁ' ? @O

saveFileas Template.. ', &y english » 57 children » 1 abc
Generate JavaDoc... ) } )

g e b=

rdatabasejava X | C ListAdapterja

() Groovy Console...

= Open Terminal... M Memory Monitor

B SO SR . - .
Sl § Sync Project with Gradle Files

import khmer.rupp.edu %' Android Device Monitor
©import khmer.rupp.edu [.i]‘ AVD Manager i
ﬁ SDK Manager

V = -
public class MainActi‘._-‘ET.b.ISfEB !?.t?gr.afl?f ~

Show: [ ]Updates/New [¥]Installed

Sort by: @ API level (©) Repository

Obsolete Select New or Updates

Deselect All

Delete packages...

I

IOfu

Done loading packages.
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6- Android Virtual Device (AVD)

An emulator configuration to simulate an actual device

¢ define hardware and software options
An AVD consists of

e A hardware profile, e.g., keyboard, memory, etc.

e A system image: target CPU chipset, API level

e Qther options: skins, appearances, SD cards, etc.
You need at least one AVD that

e AVD API level > Minimum API level of your app
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Launch AVD Manager

¢ In Android Studio
® Tools| Android | AVD Manager,

or
e the AVD Manager icon in the toolbar.

e (Command line:

r Virtual Devices

id Studio

android avd

" AVD Manager |

$

[4

ﬁ 'ﬁ' ? @o

-+ Create Virtual Device...
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Create a New AVD

e Select from a list of known configurations
e Set AVD parameters

Choose a device definition

\ ’{ Select Hardware

New Hardware Profile | | Import Hardware Profiles

@ ) [] Nexus5
Name | Size | Resolution | Density ‘
Nexus S 40" 480x800 hdpi
Tablet Nexus One 37 4804800 hdpi —
Size:  normal
. . Ratio: notlong
Wear Nexus 6 5.96' 1440x2560 560dpi Density: xhdpi
Nexus 4 47" 768x1280 xhdpi
Galaxy Nexus 4.65" 720x1280 xhdpi
Android Wear Square ~ 1.65" 280x280 hdpi
Android Wear Square ~ 1.65" 280x280 hdpi
Android Wear Round 1.65" 320x320 hdpi

Clone Device...

A Configure Hardware Profile

Device Name
Device Type

Screen

Memory

Input

Supported
device states

Cameras

| New Device

Phone/Tablet |2

Resolution: x

e

[:| Has Hardware Buttons (Back/Home/Menu)

[:| Has Hardware Keyboard
Navigation Style:

[z Portrait
[z Landscape

[z Back-facing camera

[z Front-facing camera

[] New Device

1080px

1920px

Size: large
Ratio: long
Density: xxhdpi
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Genymotion

To install Genymotion plugin for Android Studio:

1.

DB W N

In Android Studio, go to File > Settings.

Select Plugins and click Browse Repositories.

Right-click on Genymotion and click Download and install.

To see Genymotion plugin icon, display the toolbar by clicking View > Toolbar.

To use this plugin, Genymotion must be mstalled on your system.
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Create New Project

Google
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Launch Android Studio

e Start a new Android
Studio project

Q Welcome to Android Studio

Recent Projects Quick Start

EnglishForChildren
DAMITEVAndroid\EnglishForChildren Start a2 new Android Studio project
EngLishFunForKid

DAMITEVAndroid\EngLishFunFork Open an existing Android Studio project
My Application

DA\MITE\Andro

Import an Android code sample
NavigationDrawer

Check out project from Version Control
EDUkid

DAMITE\Android\EDU} ' Import project (Eclipse ADT, Gradle, etc.)
math4kid

DAMITEVAndroid\mathdkid2 Configure
CopySqlite

D-\software_project\Android\workspace\RUPPMITE\C o Docs and How-Tos

ClassAssignment

Android Studio 1.1.0 Build 135.1740770. Check for updates now.




New Project — Configuration

Choose
e Application name

e c¢.g.,Hello Android
e Company domain

e c¢.g,cs.wu.edu

Click Next

name and company domain.
Must be unique across all
\_installed apps.

(Packnge name 1s derived from app

~

New Project
H Android Studio

Configure your new project

Application name: [ HelloAndroid

Company Domain: I cs.svayrieng.edu

Package name edu.svayrieng.cs.helloandroid

ation: D:\software_project\Android\workspace\SRU\HelloAndroid

ious [ Cancel ] I Finish ]
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New Project — Form Factor

~

e (Choose the form factor
e Phone and tablet

Select the form factors your app will run on
o TV

H Target Android Devices

Different platforms require separate SDKs

® Wear [V Phone and Tablet

Minimum SDK | API 15: Android 4.0.3 (IceCreamSandwich) | v |
. Gl aS S Lower AP levels target more devices, but have fewer features available. By targeting API 15 and later, your app will
run on approximately 90.4% of the devices that are active on the Google Play Store. Help me choose.
O
L] L]
e Choose the minimum SDK =
L [:] Wear

PI level L
Minimum SDK |
lick Next

aQ »Q

(e | (N (o ) [ ]
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New Project — Activity Template

Choose an Activity ;
Template

We will start with a Blank
Activity
Click Next

A Add an activity to Mobile
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New Project —
Blank Activity with an Action Bar

e Choose :
O Activity Name X Customize the Activity
e [ayout Name
e Title

e Use the default for
this app

e C(Click Finish
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Android Project — Hello World!

= -
Edit View Navigate Code Analyze Refactor Build Run Tools VCS Window Help
PrOJeCt H O 4 SO QAR & = iwap~/ P b 3 8w ? 0 4 N\ Q
1elloAndroid Faapp > [ src ) 1 main (5 res :}‘ [£1 layout + © activity_mainxml La yo u t
N aVI ator |5 Project v D 5= | #- I+ | © MpinActivityjava X | % activity_mainxml x ’ Preview . - -l
5T Ao HelloAndio ~ Preview z
E2 HelloAndroid (D:\MITE\Android\HelloAndroid) G I:RelativeLayout xmlns:android="http://schemas.android.com/apk/res/androi [L~ [ Nexus 4+ divity- @~ ifi21+ g
b [ .idea xmlns:tools="http://schemas.android.com/tools" android:layout width= o
v [iapp android:layout_height="match parent" android:paddingleft="gdimen/act [ 3
» [ build android:paddingRight="@gdimen/activity horizontal margin" ‘g
g B android:paddingTop="gdimen/activity vertical margin" Z]
g i android:paddingBottom="@dimen/activity vertical margin" tools:contex
& v Bsrc @
=l » [ androidTest 5] <TextView android:text="E€string/hello world" android:layout width="w *850 ?
v v 1 main &) android:layout height="wrap content" /> %
% = fello world!
v [Cjava f y &
» £ edu.svayrieng.cs.helloandroid po/elatilayouty ®
v Eares =
[£1 drawable . 2
> Elloyou Layout Editor e
» 1 menu o
» I mipmap-hdpi (TeXt/X M L) E
> [E1 mipmap-mdpi 3
» [ mipmap-xhdpi ]
> [E1 mipmap-xxhdpi
2 b [Evalues
s > [ values-w820dp
o ™
:I % AndroidManifest.xml
* E .gitignore
Il app.iml
£ (& build.gradle
s
§ & proguard-rules.pro
=| » Cgradle
3 T
:3 EI .gitignore
- & build.gradle | Design | Text
Terminal 'i‘- 6: Android = 0: Messages ‘3: TODO " Event Log [Z] Gradle Console M Memory Monitor
[C] Gradle build finished in 1 min 7 sec (a minute ago) 1:1 |CRLF 3| UTF-8 | & &




Anatomy of an
Android Project

|ﬁ| Google




Android Project Structure

3 v HelloAndroid (D:\MITE\Android\HelloAndroid) |
=l » [J.idea )
e Many files and folders are generated [ v Eljovs
v » [ build / v £ edu.svayrieng.cs.helloandroid
e Let’s focus on app/src/main folder g om © & MainActivity
e The main source folder = » [ androigle

e (Contains the files to be edited
e Key files: =R

B .gitignore - E res
1 1 Il app.iml S
¢ AndroidManifest.xml S e B drawable
e res/layout/activity my.xml B proguard-nes.pro ¥ Elayout
: o . > Ll gradie © activity_main.xml
e java/edu.wu.cs.helloandroid/ %:tlgd l > B3I menu
* build.gradle . .
e MyActivity.java 3 [il gradie.properties - ] snipesap-Bag
S = gradlew » [ mipmap-mdpi
= =l gradiew.bat » [ mipmap-xhdpi
* Il HelloAndroid.iml > Blmi hdoi
r;ﬁ local.properties . e el Hi
‘g (& settings.gradle » 21 values
E » Wl External Libraries » [ values-w820dp
la'
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Elements of a Simple Android App

A simple Android app consists of
® An app manifest (XML file)
¢ app/src/main/AndroidManifest.xml
o App resources XML files)
e Under app/src/main/res
¢ layout, values, menu, drawable, mipmap-*, etc.
e One or more activities. Each activity consists of

e A Java class (Java file, under app/src/main/java), and

¢ (Usually) an associated layout resource file (XML file)
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Android App Manifest

Required for every app

e Must be 1n app/src/main/, 1.e., the root directory

e Must be named AndroidManifest.xml

Include the essential information about the app
¢ The components of the app

e The main activity of the app, 1.e., the launch point

e System requirements to run the app

e Permissions required to run the app

e Internet, location, call, etc.

27



Android Activities

e Activities are the one of the building blocks of apps
e A unit of single, focused task that a user can do

e An activity

e Serves as an entry point to app

e An app may have multiple entry points
e Associated with a single screen of Ul

e UI can be created from resources or in code
e Handles the responses to Ul events

e Interacts with other activities (inside or outside the app)

e Responds to lifecycle events
¢ (One of the) Smallest units that can be created or destroyed
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Android Resources

e Static data and contents used in the app

e Best practice: externalize resources from code
e Accommodate different configurations, €.g., screen sizes
e Support localization, different languages, e.g., French, Chinese

e Defined in XML files

e In subfolders under res

e Organized by types and configurations (default, alternatives)

e Resource types:

e Layout, string, menu, drawable, animation, style, etc.
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Android Resources — Layout

e Define the composition of Ul in XML
e The layout of a Ul screen (of an activity), or
e A component of the UI, which can be used elsewhere

e Stored in res/layout/

e A default layout file 1s created automatically
e res/layout/activity main.xml

e [t is associated with the main activity
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Hello Android — App Manifest

Edit View Navigate Code Analyze Refactor Build Run Tools VCS Window Help
DHEHO #~ X000 QR & > 4 [wap~] > & L ¥ &
2 HelloAndroid - 3 app ' "I src ' 1 main & AndroidManifestxmi

B Project v D = | B 1-

© MainActivityjava X |  activity_mainxml x | @ AndroidManifestxmi x

v [3 HelloAndroid (D:\MITE\Android\HelloAndroid)
| > [J.idea
v [Eapp
» [ build
I libs
v Osrc
b [ androidTest
v [ main
v [java
v [ edu.svayrieng.cs.helloandroid
© B MainActivity
v Ehres
[£1 drawable
[E1 layout
o activity_main.xml
1 menu
[Z1 mipmap-hdpi
[E1 mipmap-mdpi
[Z1 mipmap-xhdpi

«{ 7: Structure

[E1 mipmap-xxhdpi
[E1 values
[£1 values-w820dp
& AndroidManifestxml
B .gitignore
Il app.iml
(& build.gradle
B proguard-rules.pro

¥ 2: Favorites

4¥ Build Variants

|<’)xml version="1.0" encoding="utf-8"2>
D<manifest xmlns:android="http://schemas.android.com/apk/res/android"
package="edu.svayrieng.cs.helloandroid" >

5] <application
android:allowBackup="true"
android:icon="gmipmap/ic_launcher"
android:label="HelloAndroid"
android:theme="gstyle/AppTheme" >
<activity
android:name=".MainActivity"
android:label="HelloAndroid" >
<intent-filter>
<action android:name="android.intent.action.MAIN" />

<category android:name="android.intent.category.LAUNCHER" />
@ </intent-filter>

a </activity>

&} </application>

é(/manifest>

Manifest Editor
(Text/XML)

spaloid uaaep| 5

3IPRID (3

13puBLIWO) pi

Terminal & 6 Android = 0: Messages =2 TODO

" EventLog

[Z] Gradle Console

4 Memory Monitor

(]

Gradle build finished in 1 min 7 sec (yesterday 11:58 PM)

1:1

CRLF

UTF-8

w &
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Hello Android — App Manifest

 MainActivity.java X © activity_main.xml % @ AndroidManifestxml X

I(?xml version="1.0" encoding‘="utf-8"r?>
Elmmi fest xmlns:android="http://schemas.android.com/apk/res/android"
: package="edu.sgvayrieng.cs.helloandroid" >

l:ij <application
android:allowBackup="true"
android:icon="Emipmap/ic launcher" . o o
android: label="HelloAndroid" The main activity J
i android:theme="Estyle/AppThene" >
@ <activity
android:name=".MainActivity"
android:label="HelloAndroid" >

<intent-filter>
<action android:name="android.intent.action.MAIN" />
<category android:name="android.intent.category.LAUNCHER" />
& </intent-filter>
& </activity>

é </application>

éj</manifest>
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Hello Android — Layout
The Graphical Design View

File Edit View Navigate Code Analyze Refactor Build Run Tools VCS Window Help

ODHO #4 X000 QR &= 4w~/ b 3 8 & ? %

[ HelloAndroid [ app 'Elsrc> 1 main E‘gres\ [ layout + & activity_mainxml

Component tree

§| Ol Pojet v | © % | #- 1| © MainActivityjava X | activity_mainxml x | & AndroidManifestxml X |

g' £2 Hel #' I"rl:l @Nexus4i . “ MainActivi W
- + 1= @AppTheme MainActivity~ €9~ 1§21~
=, i Palette for layouts ==
q v |4
X v ERa o
= melayout
L and Widgets .
5 earLayout (Horizontal)
g v O LinearLayout (Vertical)
n Gl . D TableLayout
=1 » [ androidTest E
hvd ¥ Blias TableRow
v O [1] GridLayout
£ X 2 Relativelayout
v [ edu.svayrieng.cs.helloandroid
© & MainActivi ELyta
e DAY Plain TextView
v
- E y " Large Text
= Iam:’:t 2 (BB Medium Text
A — Small Text
activity_mainxml = [
B
- m.enu X Ok Small Button
>l iyt @ RadioButton
£ : E '"f”"‘ap'";:”', CheckBox
&l > B mllpmap-xx B == ToggleButton
* S H ImageButton
» [ values-w820dp Bl imageView
£ AndroidManifest.xml 2
5 EI B == ProgressBar (Large)
£ - 9 9 : == ProgressBar (Normal)
-15, ah ap?.lm == ProgressBar (Small)
@ (# build.gradle " PSR .
* I Layout Editor
Terminal & 6:Android &/ 0: Messages <2 TODO ( . )
[C] Gradle build finished in 1 min 7 sec (yesterday 11:58 PM) Graphlcal

Ba @aapo

Component Tree / =%

ﬁ' v @ Device Screen

v il Relativelayout

[Ab) TextView - @string/hello_world

Properties

layout:height

style
accessibilityLiveRegion
alpha

background
backgroundTint
backgroundTintMode
clickable

contentDescription

o LR

spafold uasep 3

3IPeID (4

1

Properties Editor

match_parent

O

" Event Log [Z] Gradle Console & Memory Monitor

nfa | nfa |&u B
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Hello Android — Layout
The Text Editor View

r Build Run Tools VCS Window Help
Vilwmapp~ | D ¥ b 3 S EHaw» ? K Q

s+ [2] layout © activity_mainxml -

€ MainActivity.java X © activity_main.xml X ‘& AndroidManifestxml % Preview £~ |
(<)) Lf?kRelativeLayout xmlns:android="http://schemas.android.com/apk/res/android" Ds, @ Nexus 4~ a, @ AppTheme “_'MainActivityv @ = .ﬁ. 21~
: xmlns:tools="http://schemas.android.com/tools"
android:layout width="match parent" - n« @-{ .« 95 Q) L

android:layout height="match parent”
android:paddingLeft="gdimen/activity horizontal margin"
android:paddingRight="fdimen/activity horizontal margin"
android:paddingTop="E€dimen/activity vertical margin"

android:paddingBottom="@fdimen/activity vertical margin"
tools:context=".MainActivity">
F—j <TextView android: text=" @string/hello world"
android:layout width="wrap content"
& android:layout height="wrap content" /> Layout preVieW J

|§J</ RelativeLayoup>

Layout Editor
(Text/XML)

| Design = Text
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Hello Android — Layout
activity main.xml

°C'(j<Relat1veLayout xmlns:android="http://schemas.android.com/apk/res/android"

xmlns:tools="http://schemas.android.com/tools"

android:layout width="match parent”

android:layout height="match parent”
android:paddingleft="fdimen/activity horizontal margin”
android:paddingRight="gdimen/activity horizonfal marain®
android:paddingTop="fdimen/activity vertical | Reference to string resource in J
android:paddingBottom="Fdimen/activity vertic( _ res/values/strings.xml
tools:context=".MainActivity">

<TextView android:text=r@string/hellq_world"
android:layout width="wrap content”
android:layout height="wrap content"” />

[§</RelativeLayout>
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Hello Android — Activity iy
MyActivity.java

187

public class MainActivity extends ActicnBarActivity {

@Override Code Editor

o[ S protected void onCreate (Bundle savedInstanceState) {
super.onCreate (savedInstanceState) ; (J ava)
setContentView(R.layout.activity main);

& }
@Override
e O public boolean onCreateOpticonsMenu(Menu menu) {
// Inflate the menu; this adds items to the action bar if it is present.
getMenulInflater().inflate (R.menu.menu main, menu) :I
return true;
& }
Override
el S public boolean onOptionsItemSelected(Menultem item) {
S // Handle action bar item clicks here. The action bar vill
// automatically handle clicks on the Home/Up button, so long
&) // as you specify a parent activity in AndroidManifest.xml

int id = item.getItemlId():

F &Y { - -~ - - - - - P -
//noinspection SimplifiablelfStatement

if (id == R.id.action settings) ({
return true;

return super.cnCptionsItemSelected(item);
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Hello Android — Activity T
MyActivity.java

g

épublic class MainActivity extends ActionBarActivity {

Reference to
res/layout/activity main.xml

§ Override
@TIQ protected void onCreate (Bundle savedInsta te) {
: super.onCreate (savedInstanceState);

setContentView(R.1ayout.activitg;mafh):

S
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Build and Run
Android Apps

|ﬁ| Google




Run/Debug App on Emulator

¢ In Android Studio
e Run| Run ‘app’, or
e the Run icon in the toolbar
e Run| Debug ‘app’, or
e the Debugicon in the toolbar

e Selectan AVD

e Choose a running device, or

e [.aunch an emulator

Mi Run ‘app’ (Shift+F10) L"
'w app v |(D>| o [

(*) Choose a running device

Device | Serial Number | State |Com..
@ Genymotion My Nexus - 4.3 - AP| 18 - 720x|192.168.56.101:5555 |Online | Yes

@ LGE LG-P880 Android 4.1.2 (API 16) 015d2d424d4c1e05 Online  Yes

(O Launch emulator

Android virtual device: | Nexus 5 API 21 x86 J

[] Use same device for future launches

"o ==
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Run App on Emulator

- Genymotion for personal use - My Nexus -4.3.. = B “

HelloAndroid

Hello world!
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Edit App Resources
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Edit Widget Properties

e Open

indow Help

layout/activity my.xml LY@ SLER 70 Q
xml
) Select the D681 gnVleW activity_mainm x | AndroidManifestami X | | £
[,-lv [!—L;]Nexusb av (D AppTheme = MainAdtivity~ €~ 1§21~ Component Tree T =% g
° b (&)~ @ e ® QB 3 v i Device Screen §
. SeleCt the TeXt Vlew Wldget 95 i v RelativeLayout *
TextView - @string/hello_world o
e Text View displays a static
text. Often known as a label. Sl
e FEdit the attributes =
normal ([l &
* textColor b u
italic O
o textSize i

o textStyle
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The Text View — Change Text Styles

[é <TextView android:text="€string/hello world"
5 android:layout width="wrap content”
android:layout height="wrap content”
android:textColor="#££992d00"

é] android: textStyle="bold" /> Ihmﬂaﬂmﬂaf}
: ARGB

m )
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Attributes of String Values

e The text attribute refers to a string resource

<TextView android:text="Estring/hello world"

Strings begin with @ are
references to resources (defined in
XML)
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Homework

e C(reate the Android Project
e Edit resource to change the Hello World! To

e Your name
e Your Major

e Academic Year

¢ And Runnable on your Emulator
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Thank you!
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